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1. Operator’s Manual
1.1. Getting Started
1.1.1. Introduction to Using ConcreteWorks
ConcreteWorks is a suite of Windows®-based concrete technology programs intended for
use by engineers, researchers, inspectors, contractors, and precasters already familiar with concrete
materials and construction practices. The first program in the series is the self-titled
ConcreteWorks program. ConcreteWorks is a concrete durability design tool that may be used to
predict temperature development, thermal stress cracking probability, or the concrete chloride
service life for various concrete members, as explained in the software introduction.
ConcreteWorks is meant to be used by operators described above that have a working knowledge
of concrete behavior. It is recommended that ConcreteWorks users thoroughly read the background
information on the software to understand some of the limitations and the assumptions made in the
software.
Mix Proportions is a program that assists the user in concrete mixture design and
proportioning. Mix Proportions is based on the procedures outlined in ACI 211 (1991) and
National Highway Institute (NHI) Course 15123 (Hover, 2003). This operators’ manual provides
help with using the program ConcreteWorks. No warranty of the accuracy of results calculated by
any of the ConcreteWorks programs is given or implied.
1.1.2. Installation
To install ConcreteWorks, the target computer must be running the Microsoft .NET
Framework v3.5. The .NET Framework should be updated through automatic updates.
Once the target computer is running the .NET Framework, you may install ConcreteWorks.
ConcreteWorks may be downloaded from https://iowadot.gov/bridge/Mass-ConcreteFundamentals-November-2019. Once downloaded, the user should unzip the downloaded file and
double-click on the setup.exe file to begin installation. The program should then start the
Installation Wizard.
The installation wizard will guide you through all of the necessary steps to install
ConcreteWorks. The first screen is the installation welcome screen. Click the Next button to
continue with the installation. The second screen contains the End-User License Agreement
(EULA). Click the I Agree button if you agree with the terms of the EULA, and then click Next. If
you do not agree with the terms of the EULA, click I Do Not Agree and then Cancel, ending the
installation process. The software will not install unless you signify that you agree to the terms of
the EULA by clicking, I Agree. Internet Explorer must be on the computer to access the official
ConcreteWorks website from ConcreteWorks as described in Section 1.4.7. Lack of access to
Internet Explorer could result in an error and/or the program crashing.
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Adobe Reader® is also required to be installed on the computer to access the
ConcreteWorks User Manual as described in Section 1.4.7. Failure to have Adobe Reader®
installed on the computer could result in an error and/or the program crashing.
1.1.3. Navigating the Program
There are two methods of opening a new or saved file in ConcreteWorks. The first method
is to click on the New File or Open Existing File toolbar button. The second method is to click New
or Open under the File Menu. Figure 1 shows a zoomed in view of the upper left side of
ConcreteWorks. The red arrows point to the different menus and toolbars available in
ConcreteWorks. If a file is already open, the program will prompt to save the current file. If the
Yes button is clicked, the program follows the save procedure outlined in Section 1.4.4. If a file is
not already open, the program will prompt the user for a filename and location, as described in
Section 1.4.3.

Figure 1 - Close-up view of toolbars and menus
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There are also two methods of changing the current input/results screen in ConcreteWorks.
The navigation toolbar found at the top of the program allows the user to quickly navigate between
input/results screens. Each button, when clicked, displays the corresponding input/results screen.
Clicking on the Next button displays the next chronological input screen. Clicking the Back button
displays the previous screen shown. The navigation toolbar shows the order the screens are
displayed.
For more information on the printing features found in the File menu, see Section 1.4.1.
See Section 1.4.6 for more information on the Tools menu and Section 1.4.7 for more information
on the Help menu.
1.2. Inputs
1.2.1. Member Type
When a new file is selected, the user is prompted to select the type of member to analyze.
In ConcreteWorks v3.1.0, the user may select from four basic types of concrete members: mass
concrete, bridge decks, pavements, or precast beams. The input screens available will depend on
the type of member selected and will only be shown if needed. For example, the Corrosion Inputs
screen is not available when the user selects the Precast Concrete member type because
ConcreteWorks does not contain a chloride service life module for precast beams. This manual
will explain the inputs for all member types; note that if the input is not applicable for a particular
member type, it will simply not be shown in the software. Additionally, the next and back buttons
will show the next input screen available in the same order as the order of inputs shown in the input
screen navigation toolbar shown in Figure 1.
1.2.2. General Inputs
The basic model settings and project inputs are all done in the General Inputs screen, as
seen in Figure 2. The General Inputs screen is the first screen shown after opening a new or saved
file, which is why there’s not a Back button shown. Changing the inputs in the General Inputs
screen will fundamentally change other data entered later in the program. Changing the placement
date, analysis duration, or project location will cause the weather data to change, even if maximum
or minimum values have been entered earlier.
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Figure 2 - General Inputs screen
Units
Many inputs in ConcreteWorks can be entered in either English units or Metric (S.I.) units.
The English units’ system is the default units system in ConcreteWorks. When the system of units
is changed, the program will prompt the user to change all values or cancel to stay in the current
unit system. If the user chooses to change the values entered, the program assumes that the user
entered the correct values for the old unit system and will then multiply the entered values by the
appropriate conversion factor for the new unit system. The Chloride Units input allows the user to
select to perform the chloride service life calculations by % Chlorides by mass of concrete, or by
mass per unit volume. The chloride surface concentration inputs in the Corrosion Inputs will be in
the units chosen, as will the steel chloride threshold at corrosion initiation values, and the initial
chloride concentration values.
Project Time and Date
The Placement Time box allows the user to enter the time concrete placement is started on
the element being analyzed. If the cross section being analyzed is a horizontal cross section (such
as a column), then the user should input the time concrete is placed at the particular cross section
being analyzed. The default time is 7:00 a.m.
The Placement Date is entered by clicking on the number corresponding to the date of
concrete placement. The month or year of placement can be changed by either clicking on the
appropriate arrow or by clicking on the month or year. The default date is the current date.
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Accurate results in ConcreteWorks depend on the user entering the correct time and date.
Even if the minimum and maximum weather data is entered later in the program, the correct date
and time must still be entered. The shape of the weather data plots is extracted from 30-year average
data. Because of the changing sunrise and sunset times, every day has fundamentally different
shape of the weather data plot. Entering the correct maximum and minimum weather data later in
the program will give the correct overall magnitude for the weather data plots but will not change
the weather data’s fundamental shape.
Analysis Setup
ConcreteWorks predicts the temperature development of a concrete cross section for the
number of days selected under the Analysis Duration option. The default number of days is 7. The
Chloride Service Life Analysis Duration input allows the user to select the number of years that
are used to calculate the chloride ingress into the concrete. If the steel chloride threshold has not
been exceeded during the time period selected for the Chloride Service Life Analysis Duration,
then the results will show that the time to corrosion initiation will be greater than the Chloride
Service Life Analysis Duration.
Project Location
Under the Project Location option, the user should select the closest city to the construction
site that has a similar climate. Besides using the drop-down list of cities to select the project
location, cities in the currently selected state can be selected by clicking on the city name in the
city map. When installed, ConcreteWorks automatically installs weather data files for eight Iowa
cities (as shown on the map on the General Inputs screen). The files are located in the same folder
as the ConcreteWorks application. Weather files for states other than Iowa may be installed during
the installation process. ConcreteWorks automatically detects all weather files located in the same
folder as ConcreteWorks and adds them to the drop-down list of available cities. Caution: only
genuine ConcreteWorks weather files can be recognized by ConcreteWorks. Other weather files
may cause an error in the program.
1.2.3. Shape Inputs
ConcreteWorks can predict the temperature distribution for several types of mass concrete
elements. All available concrete shapes available according to the type of concrete member
selected are listed in the Shape Inputs screen.
Available Shapes
ConcreteWorks has the capability of predicting temperature development in six unique
mass concrete member types, four types of bridge decks, and four precast beam shapes.
ConcreteWorks also has a pavement temperature prediction built in, but because only one concrete
pavement type is allowed, the Shape Inputs screen is not shown when pavement member types are
selected. Figure 3 shows the mass concrete shapes available in the Available Shapes frame. Figure
3 shows the four types of bridge deck types available in the Shape Inputs screen, while Figure 4
shows the precast beam types available. When a shape is checked, a picture of the shape is shown
to the right for confirmation. Once the desired shape is selected, proceed to the next screen.
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Figure 3 - Shape Inputs screen for mass concrete member types

Figure 4 - Shape Inputs screen for bridge deck member types
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Figure 5 - Shape Inputs screen for precast beam member types
1.2.4. Member Dimensions
Each unique concrete cross section type will display a different picture and inputs on the
Member Dimensions screen. All shapes, however, use the same basic format. Figure 6 shows the
Member Dimensions screen for the Rectangular Column member.
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Figure 6 - Member Dimensions screen for the Rectangular Column element
Dimensions
Each shape will require the user to enter the member cross-sectional dimensions. All
dimensions input will correspond to the same dimensions on the picture on the left side. Because
the program’s focus is on transportation-related concrete (bridges and pavements), ConcreteWorks
limits the size of some member dimensions. The Rectangular Column, Rectangular Footing,
Partially Submerged Rectangular Footing, and Rectangular Bent Cap have minimum dimensions
of three feet each. The Circular Column has a minimum diameter of three feet. The T-Shaped Bent
Cap has a minimum seat height of 9 in. and a minimum top width of 1.5 feet. The overall cap
height must also be 1.5 feet taller than the seat, and the overall cap width must be 1.5 feet greater
than the top width. If an invalid dimension is entered, an error will appear when the user attempts
to calculate the member temperature development using the Calculate Temperatures button on the
Input Check screen. Member dimension limits for decks and pavements are enforced by the
numeric-up-down control used to input the dimension. The Overall Deck Thickness is limited to
14 in., while the Precast Panel Thickness is limited to 8 in. The Pavement Thickness, Subbase 1
Thickness, and Subbase 2 Thickness are all limited to 24 in.
Pavement analysis is broken up into different layers with different material properties, as
shown in Figure 7. Users may select up to two types of subbase materials, in addition to the
pavement and subgrade. The subgrade material is assumed to extend infinitely beneath the subbase
layer(s). Pavement layer dimensions and types are not changed in ConcreteWorks until the user
clicks on the Re-Draw Pavement System button. The figure to the right of the pavement dimensions
inputs will then update, allowing the user to check the currently selected inputs.
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Figure 7 - Pavement Dimensions Input screen
Submerged
Some of the available member types have the option of being submerged in water. This
means that the cross section being modeled is completely immersed in water. One example of when
the submerged option would be selected is when a column is placed in a lake or ocean.
Soil on the Sides
Some member types have the option of modeling soil on the sides of the member. This
option is selected when earthwork is used instead of formwork. Figure 8 shows an example of the
type of member that would use soil on the sides instead of formwork.
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Figure 8 - Example of a footing that would use the “soil on the sides” option
Cross Sections Analyzed
Temperature predictions are in some cases based on one- or two-dimensional cross sections
of the member. When ConcreteWorks does not calculate the temperature distribution for a
direction in a concrete member, the program assumes that there is no heat loss in that direction
(i.e., perfectly insulated). For example, with the rectangular column, ConcreteWorks calculates the
temperature profile of a horizontal cross section of the column. The program assumes that there is
no heat loss from the top of the column to the air or from the bottom of the column to the footing.
This assumption is a valid assumption for the vertical middle of the column and becomes less
accurate towards the ends in the column.
When the user decides to analyze a rectangular footing or partially submerged rectangular
footing in three dimensions, the temperature distribution in the footing is calculated for all three
directions. Calculating the temperature in three dimensions can give slightly better results in some
cases, but significantly increases the calculation run time. The user only has the option of
calculating the footing temperature in three dimensions when the user does not select soil on the
sides of the footing. When the user selects to calculate a two-dimensional cross section of the
footing temperatures, as seen in Figure 9, the width side is used in calculations. The length
dimension entered is then ignored. The user should enter the smaller dimension of the two
horizontal footing dimensions in the width text box. The user can also opt for a one-dimensional
analysis of the rectangular footing, as shown in Figure 9.

11

Figure 9 - Rectangular Footing screen with Two-Dimensional Analysis selected
Precast Panel Inputs
When the user selects a Generic User Defined Bridge on the Shape Inputs screen, then the
user has the option of selecting to use a precast panel and the number of mats of steel. Figure 10
shows the Bridge Deck Dimensions Inputs screen when the Generic User Defined Bridge deck
type is selected. When the user selects two mats of steel and a precast panel, the bottom mat of
steel is assumed to be made of prestressed strands.

12

Figure 10 - Bridge Deck Dimensions Input screen when the Generic User Defined Bridge Deck
Type is selected
1.2.5. Mixture Proportions
The Mixture Proportions screen is where the user inputs the concrete batch information, as
seen in Figure 11. If blended cement is used, the user should enter the fly ash and cement quantities
separately, as if they were added to the concrete completely separate.
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Figure 11 - Mixture Proportion Inputs screen when a rectangular footing type is selected with
mass concrete member
Mix Proportion Inputs
All information found in the Mix Proportion Inputs area must be inputted correctly for the
program to generate a heat signature curve for the concrete. Mixture information is entered by the
amount of weight of a particular material for every unit volume (pounds per cubic yard for English
units, kilograms per cubic meter for SI units). The aggregate contents are entered assuming the
aggregate is saturated surface dry (SSD). The water is entered based on total amount of free water
available for hydration (aggregate moisture not absorbed + water/ice added).
Supplementary Cementing Materials
The Supplementary Cementing Materials (SCM) frame is where SCMs are input. To
include an SCM in the batch, check the box corresponding to the particular SCM. Enter in the
amount of SCM used in the batch. The program defaults the free lime content of the ASTM Class
C fly ash to 29% and the ASTM Class F fly ash to 19%. These values can be changed if the free
lime content of the fly ash used is known. To remove the SCM from the batch, simply uncheck the
corresponding box or set the amount used to zero.
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Calculated Mixture Proportions
The Calculated Mixture Proportions frame displays calculated mixture ratios based on the
current values entered. The Sacks of Cement/volume quantity is based on the total number of 94pound sacks of cementitious materials used in the batch (cement + SCMs) per cubic yard/meter.
The number of Gallons of water per sack/liters per sack figure is the amount of water per sack of
cementitious materials. The density of the water is assumed to be 1g/cm3 (62.43 lb/ft3). The
Water/Cement Ratio is equal to the water content entered divided by the cement content. The
Water/Cementitious Ratio is equal to the water content entered divided by cementitious materials
content.
Chemical Admixture Inputs
Chemical admixtures are entered by checking on the admixture. To simplify mixture
proportion inputs, typical values of chemical admixture doses are assumed as shown in Table 5.
Bottom Panel Mixture Proportions
When a bridge deck member type with precast panels is selected, the user may change the
bottom panel mixture proportions by clicking the button Click to Change Bottom Panel Mixture
Proportions. When this button is clicked, an input screen similar to the Mixture Proportion Inputs
screen is shown. Figure 12 shows the Precast Panel Mixture Proportions Inputs screen that is
displayed. Here, the user may enter the mixture proportions used in the precast panel concrete.
Although the precast panel is assumed to not generate any heat, the concrete diffusion coefficients
used in the chloride service life analysis is determined from the concrete panel mixture proportions.

Figure 12 - Precast Panel Mixture Proportions Inputs screen
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1.2.6. Concrete Mixture Proportioning
If the user needs help with the concrete mixture design and proportioning, the user may
click on the Go to Design of Mixture Proportion button on the lower right corner of the Mixture
Proportions screen, as seen in Figure 13. The Design of Mixture Proportion screen will appear, as
seen in Figure 13. The Design of Mixture Proportion screen guides the user through the mixture
proportioning steps as found in ACI 211 (1991) and NHI Course 15123 (Hover, 2003). For a more
detailed presentation of the mixture proportioning procedure and limitations, please refer to ACI
211 (1991). The most important thing to remember about the mixture proportion calculations is
that they are only designed to create the proportions for making and testing a trial batch. The
calculations in the Design of Mixture Proportions screen can never be used as a substitute for local
knowledge of material properties or for trial batches. This is designed to be a user-friendly tool as
the first step in designing mixtures for field applications.
The Cancel button on the Design of Mixture Proportion screen sends the user back to the
Mix Proportions Inputs screen without any changes being made to the material weights. The OK
button sends the user back to the Mixture Proportions Inputs screen, changing the material weights
to those shown in the Final Volume Calculations. When a chemical admixture is checked in the
Water Adjustment tab, the admixture is then checked on the Mix Proportions Inputs screen. When
the High-Range Water Reducer (Type F) box is checked in the Design of Mixture Proportion
screen, ConcreteWorks assumes that a Naphthalene-based admixture is used.

Figure 13 - Design of Mixture Proportion screen—General Mix Information inputs
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General Mix Information
The General Mix Information tab of the Design of Mixture Proportion screen displays all
of the general material specifications. If not entered manually, the w/cm ratio is calculated from
the Target Strength shown in the Strength Requirement frame, the air content, and any minimum
w/cm ratios imposed by selecting a severe exposure condition from ACI 318-05 Tables 4.2.2 or
4.3.1.
The target strength is calculated by default on the specified f’c increased by the percent
increase in target strength value. Alternatively, the user may calculate the concrete target strength
by checking the box for using the concrete standard deviation, and then entering the standard
deviation.
Aggregate Properties
The Aggregate Properties tab allows the user to either input the aggregate properties or
calculated some of the inputs needed from an aggregate sieve analysis. Figure 14 shows the
Aggregate Properties tab. Sieve Analysis Data for each aggregate type used should be entered as
percent passing. Additionally, the percent of each aggregate used should be input as percent of the
coarse or fine aggregate used, not the total amount of aggregates used. When the Update Agg.
Properties button is clicked, the combined Coarse Aggregate Specific Gravity, combined Fine
Aggregate Specific Gravity, and Maximum Size Aggregate inputs are updated. Additionally, the
aggregate gradation charts are updated when the Update Agg. Properties button is clicked. An error
is generated when the user enters a percent passing value that is larger than that from a larger size
sieve, when the sum of coarse aggregate percent used values does not equal 100 percent, or when
the sum of fine aggregate percent used values does not equal 100 percent. When the user checks
the button that states Instead of ACI 211, optimize aggregate weights by: the software will calculate
the aggregate amounts to use by optimizing the selected aggregate gradation index selected instead
of the ACI 211 methods.
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Figure 14 - Aggregate Properties tab on the Design of Mixture Proportions Inputs screen
Water Adjustment
The Water Adjustment tab contains tracking bars that let the user adjust the water
requirements for the concrete by moving the tracking bar values, as seen in Figure 15. To use a
water reducer, check the corresponding box on the Water Adjustment tab. Then move the track bar
value to correspond to the water reduction gained from that particular admixture. The values used
for maximum and minimum water reduction for all factors come from the NHI Course 15123
(Hover, 2003). A local knowledge of the water reduction properties for all the materials is
extremely important. The quality of the concrete mixture designed will depend greatly on the
accuracy of the inputs. Trial batches should always be made to verify the slump and strength
properties of the concrete.
The Adjusted Water Content shown in the Paste Content frame is calculated based on the
desired slump, the percent air, the aggregate gradation, and any water requirement adjustments
made in the Water Adjustment tab (as described in Section 1.2.6). The cementitious material
content is calculated by dividing the Adjusted Water Content by the w/cm ratio.
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Figure 15 - Water Adjustment tab on the Design of Mixture Proportion screen
Final Volume Calculations
The final volume calculations for the concrete mixture are calculated based on the
aggregate properties, cement content, adjusted water content, mineral admixture replacement, and
air content. The batch weights per yard of concrete are shown in the Final Weights frame. The pie
graph shows the percent of each material in the concrete mixture by volume. Figure 16 shows the
Final Volume Calculations tab. When the total calculated paste content exceeds 30% by volume a
warning appears to warn the user that the concrete mixture may be more susceptible to drying
shrinkage. This does not preclude the use of the concrete mixture, but caution should be used for
concrete members with a high surface area-to-volume ratio when exposed to low relative humidity.
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Figure 16 - Final Volume tab of the Design of Mixture Proportion screen
1.2.7. Material Properties
The material characteristics are entered in the Material Properties screen. Figure 17 shows
the Material Properties screen. To manually override the default cement chemistry and hydration
parameters, check the corresponding boxes and enter in the desired values, as seen in Figure 18.
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Figure 17 - Material Properties screen

Figure 18 - Material Inputs screen with manual adjustment checkboxes checked
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Cement Chemical/Physical Properties
The Cement Chemical/Physical Properties frame is where the cement type, composition,
and physical properties are entered. To change the cement properties to those for the cement used,
check the Check to manually enter cement chemical/physical properties box. If the user unchecks
the Check to manually enter cement chemical/physical properties box, the cement properties revert
back to the default values for the cement type selected. When the Bogue method is selected under
the Cement Analysis Method found in the Tools menu, the Bogue values and oxide contents for the
cement properties are displayed. If the Rietveld method is selected instead of the Bogue method,
then the cement composition phases corresponding to that method is displayed. Actual cement
properties estimated using the Bogue method can be found on mill sheets shipped with the cement.
Hydration Calculation Properties
Hydration Calculation Properties are based on equations developed as part of TxDOT
research project 0-4563 and are described in Section 3.1.5. Different models that describe the
Hydration Calculation Properties are used depending on whether the Bogue method of the Rietveld
method is used to define the cement properties. If the user has performed a semi-adiabatic
calorimetry test on the concrete mixture used, then the calculated hydration properties can be
changed by checking the Check to manually enter hydration properties box. When the Check to
manually enter hydration properties box is checked, the hydration parameters do not change when
the mixture proportions is changed, or the cement type changes. The semi-adiabatic calorimetry
test performed to determine hydration parameter equations for ConcreteWorks Version 3.1.0 came
from mixes that used Iowa materials. If the concrete material properties deviate substantially from
those used in Iowa, a semi-adiabatic calorimetry test should be performed to determine the
hydration parameters.
Aggregate Factors
Choose the type of coarse and fine aggregates used in the concrete batch. Up to three coarse
aggregates types can be blended, while up to two fine aggregate types may be used. The user may
change the number of coarse aggregates blended by changing the number in the # of Coarse
Aggregate Types drop-down menu, and the number of fine aggregates blended by changing the
number in the # of Fine Aggregate Types drop-down menu. When more than one type of aggregate
type is selected to be blended, additional corresponding drop-down menus will appear that prompt
the user for the type of additional aggregate used. The coefficient of thermal expansion (CTE) and
material thermal properties are calculated based on the mixture proportions and the coarse
aggregate types. The CTE and material thermal properties may be input by the user if a hardened
concrete CTE test, hardened concrete thermal conductivity test, or aggregate specific heat test is
performed. The combined aggregate cp value shown in Figure 18 is the Ca parameter shown in
Equation 24. It is highly recommended that the user performs a hardened concrete CTE test on the
concrete mixture to be used, as the thermal stresses calculated are very sensitive to the concrete
CTE. When the checkbox Check to Manually Enter the Concrete Coefficient of Thermal Expansion
and Thermal Properties is unchecked, the concrete CTE and thermal properties revert to default
values as calculated according to the chosen aggregate types.
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1.2.8. Mechanical Properties Inputs
The Mechanical Properties Inputs screen allows the user to input the type of maturity
method used, the maturity-strength relationships, and the early age creep parameters as shown in
Figure 19.

Figure 19 - Mechanical Properties inputs
Maturity Functions
The Maturity Functions frame allows the user to select between the Nurse-Saul method of
maturity and the Equivalent Age method, both as described in ASTM C 1074 (2004). For the
Nurse-Saul method, a reference temperature of 0°C is used when metric units are selected and 0°F
is used as the reference temperature when English units are selected. If the user has a maturity
curve already calculated for the given concrete mixture, the user may enter the a and b strength
parameters according to the equation shown on the Materials Inputs screen. The Check to calculate
thermal stresses when temperatures are calculated checkbox must be checked for the software to
calculate the concrete member cracking probability failure classification. When thermal stresses
are to be calculated, the equivalent age maturity method must be used. The elastic modulus and
splitting tensile strength equations are calculated from the concrete compressive strength fit
parameters entered. At a minimum, the compressive strength/maturity relationship must be entered
for the concrete mixture proportions and materials used. The accuracy of the thermal cracking
probability analysis increases when the elastic modulus and splitting tensile strength are measured
and input in the software.
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Early Age Creep Parameters
The concrete early age creep is calculated using the Modified Linear Logarithmic Model
(MMLM). The early age creep parameters for the MLLM are calculated from the mixture
proportions and material properties entered. Different equations are used, depending on whether
the Bogue method or the Rietveld method is selected.
1.2.9. Construction Inputs
The Construction Inputs screen is where the construction-related options are entered. Each
type of concrete member will have different construction options to choose from. ConcreteWorks
will automatically display the needed inputs based on the other options selected by the user, such
as member type or whether the member is submerged. Do not be alarmed if a particular set of
inputs does not appear with the particular choices made. If you change the member shape or
submerged status, the available construction inputs will change. Even small mistakes, such as the
form type, or blanket insulation, can yield dramatically different results. Figure 20 shows the
Construction Inputs screen for a rectangular column.

Figure 20 - Construction Inputs screen for a rectangular column
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Concrete Placement Temperature
The Estimated Placement Temperature is the temperature of the concrete when it arrives
on the jobsite. The concrete placement temperature can be calculated three ways.
The first way is to click on the Calculate button. After it is clicked, the Raw Material
Temperature Inputs screen will pop up. The temperature of the cementitious materials, aggregates,
and water must be entered. Aggregate moisture contents and absorptions must also be entered.
Optionally, ice may be entered if it is used in the batch. The OK button will not work until all of
the required information is entered. After all of the required information is entered and the OK
button is clicked, the calculated placement temperature will be displayed in the Estimated
Placement Temperature box. ConcreteWorks uses the ACI 305 model for predicting the fresh
concrete temperature (ACI 305R, 1991). When the Mixture Proportion inputs are changed, the
predicted fresh concrete temperature will also change, if all of the required inputs are entered in
the Raw Material Temperature Inputs screen. Note: if all of the required inputs in the Mixture
Proportion Inputs screen are not entered, ConcreteWorks will not be able to calculate the fresh
concrete temperature.
The second way is to calculate the concrete placement temperature from the ambient
temperature. In this method, the concrete fresh temperature is estimated as the ambient temperature
at the time of placement.
The third way to enter the concrete placement temperature is to check the Check here to
manually enter Fresh Concrete Placement Temperature box. After the box has been checked, the
user may enter the concrete placement temperature in the Estimated Placement Temperature box.
If the Check here to manually enter Fresh Concrete Placement Temperature box is checked, the
value in the Estimated Placement Temperature box will only change when manually entered by
the user.
Formwork
The Concrete age at Form Removal input requires the user to input the concrete age when
formwork is removed (at the cross section being analyzed), starting from the time the concrete was
first mixed. The form type and form color must also be input in their corresponding boxes.
Surrounding Temperature
If the element selected is a footing or the element is submerged, the Construction Inputs
screen will have inputs for the soil temperature and water temperature. The soil temperature refers
to the average soil temperature for the time being modeled. A good estimate of the soil temperature
for most footings is the average of the maximum and minimum ambient temperatures during the
time period in question. The water temperature refers to the temperature of the water surrounding
a concrete element. For example, if a column was being placed in a lake, the user would enter the
average lake water temperature for that time period.
Curing Methods Applied after Forms Are Stripped
The After Forms Are Stripped area asks the user to input what kind of curing methods are
applied to the member after the forms are removed. ConcreteWorks requires the user to enter a
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time in the box Time between form removal and curing method applied if a cure method is checked.
If the user enters a delay time, but does not check a cure method box, ConcreteWorks assumes that
no cure methods are used. The user cannot check both the Black Plastic option and the White or
Clear Plastic option at the same time. If for some reason, both types of plastic are used in
construction, the user should check the type of plastic used as the outside layer. All curing methods
applied after forms are stripped are assumed to remain on the concrete member until the end of the
analysis duration. The default time between removing forms and applying the cure method is one
hour.
Footing Inputs
When a footing is selected as the member type, the Footing Inputs frame becomes visible
on the Construction Inputs screen, as seen in Figure 21. The input Type of footing subbase asks the
user to select the type of soil or rock on which the footing is built. If a plastic sheet is also used in
curing, the user should select which color plastic is used. If both types of plastic are used, the user
should select the color of the plastic placed on top. The input Concrete age when cure blanket is
placed is the number of hours between concrete placement time and when cure methods are applied
(the cure methods applied to the top before form removal). This input allows the concrete to set
before placing the cure blankets on top of the footing.
If the sides of the footing are shaded from the sun because of scaffolding or the ground, the
user should check the input Footing Sides Shaded.

Figure 21 - Construction Inputs screen shown when the rectangular footing member shape is
chosen
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Bent Cap Inputs
The user must select which type of form is used for the bottom of the bent cap. This allows
the user to use different forms for the sides and bottom of a bent cap. For example, the user could
select steel forms for the sides of the bent cap, and wood for the bottom. If the user selects Precast
Concrete for the bottom form of the cap, the Precast Concrete Section Thickness input box appears,
as seen in Figure 22. The default cap bottom form type is steel. The default precast concrete
thickness is two feet. The Concrete age when cure blanket is placed is the number of hours between
concrete placement time and when cure methods are applied (the cure methods applied to the top
before form removal). This input allows the concrete to set before placing the cure blankets on top
of the bent cap. If a plastic is used on top of the cure blanket before form removal, the user should
select which color plastic is used. If more than one color of plastic is used, the user should select
the plastic placed on top.

Figure 22 - Construction Inputs screen for a rectangular bent cap with pre-cast concrete selected
as the bottom form
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Bridge Deck Inputs
ConcreteWorks assumes that a cure blanket is used on top of bridge decks. The user may
additionally select to use a layer of plastic on top of blanket, the time the blanket is placed, and the
concrete age when the cure blanket is removed. If wood forms are selected for the bridge deck, the
user may additionally specify the concrete age at the wood form removal, as shown in Figure 23.

Figure 23 - Bridge Deck inputs when wood forms are selected
Precast Concrete Construction Inputs
Precast concrete members allow the user to specify a tarp or blanket to be used on the
member sides. When a tarp or blanket is used on the sides of the precast beam, the same R-value
is used for the blanket on the top and sides of the beam. The software also allows the user to select
the subbase underneath the precast member, and the age when the cure method is started. The cure
method is assumed to end when the forms are removed.
Pavement Construction Inputs
ConcreteWorks asks the user to input the type of cure method used as shown in Figure 24.
The other pavement curing options depends on the curing method selected, and may ask the user
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for the application rate, the time of cure method application and removal, and the cure method
color.

Figure 24 - Pavement Construction inputs
Blanket Insulation R-Value
The Blanket Insulation R-Value frame allows the user to select the R-Value of all cure
blankets used during the concrete member construction. The R-Value is a measure of the blanket’s
thermal insulation. A high R-Value indicates a good insulator. Recommended R-values are 3
in.2hr-F/BTU for a thick, good quality cure blanket and 1 in.2-hr-F/BTU for burlap or worn cure
blankets.
Form Liners
The Form Liners frame asks the user to input which sides of the member use form liners.
The width and depth sides correspond to the width and depth sides input in the Member Dimensions
screen. ConcreteWorks assumes that the form liners are solid rubber reusable form liners (such as
the Symons brand Elasto-Tex™2 form liner).

2

The Elasto-Tex™ trademark belongs to the Symons Co.
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1.2.10. Environment Inputs
The Environment Inputs screen is where all weather inputs are entered. All weather inputs
are entered in tables that function similar to cells in a spreadsheet. ConcreteWorks requires that the
user enter one more day than the number of days selected for analysis. The first day entered is the
day selected as for the project date. Default values are the average 30-year weather data for the
days selected for each individual city. When the user changes the Placement Date, Temperature
Analysis Duration, or project location on the General Inputs screen, the environment inputs are
automatically updated to the 30-year average values. The environmental inputs will always be
updated, even if the user checks the boxes to input maximum and minimum weather values
manually. Care should be taken to manually input environment values last. Clicking on the table
headings will sort the table by the values of the column clicked on. The overall data will not be
affected by sorting the data.
Temperature
The maximum and minimum temperature for each day is shown in the table on the
Temperature tab. Default values can be overridden by checking the Check to manually enter
temperature data input. Next, click on the table cell desired, and change the maximum or minimum
value. Figure 25 shows the Environment Inputs screen with the Temperature tab selected.

Figure 25 - Temperature tab on the Environment Inputs screen
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Relative Humidity
The maximum and minimum relative humidity for each day are shown in the table on the
Relative Humidity tab. Default values can be overridden by checking the Check to manually enter
humidity data box. Next, click on the table cell desired, and change the maximum or minimum
value.
Percent Cloud Cover
Average daily cloud cover value for each day is shown in the table on the Percent Cloud
Cover tab. Default values can be overridden by checking the Check to manually enter cloud cover
data box. Next, click on the table cell desired, and change the average cloud cover value. Enter
cloud cover according to the scale shown. A zero-cloud cover value is entered for sunny conditions,
50 for partly cloudy, and 100 for overcast. Figure 26 shows the Environment Inputs screen with
the Percent Cloud Cover tab selected.

Figure 26 - Percent Cloud Cover tab on the Environment Inputs screen
Wind Speed
Maximum wind speed value for each day is shown in the table on the Wind Speed tab.
Default values can be overridden by checking the Check to manually enter wind speed data box.
Next, simply click on the table cell desired, and change the maximum wind speed value.
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Yearly Temperature
The yearly temperature profile is calculated based on the number of temperature points per
year selected as shown in Figure 27. Additionally, under the input Temperature Value to Use, users
can select to use the average temperature values, the average temperature plus one standard
deviation, or the average plus two standard deviations. The yearly temperature profile is used in
calculating the chloride service life. The estimated chloride service life is not very sensitive to the
number of data point per year selected but is moderately affected by using the average temperature
plus one or two standard deviations.

Figure 27 - Yearly Temperature inputs
Summary Graphs
The Summary Graphs tab can display the updated weather data on a graph. All plots start
at 1:00 a.m. on the project date selected. The Temperature button shows a plot of temperature data
with time. The Humidity button displays the relative humidity data with time. The Wind Speed tab
shows a plot of wind speed with time. The Solar Radiation tab shows a plot of solar radiation with
time. The solar radiation values are calculated based on the cloud cover data and relative humidity
data. Figure 28 shows the Environment Inputs screen with the Summary Graphs tab selected. The
graph shown in Figure 28 is a plot of the temperature.
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Figure 28 - Summary Graphs tab on the Environment Inputs screen (the temperature graph is
currently displayed)
1.2.11. Input Check
The Input Check screen shows the values that have been entered, providing the user an
opportunity to catch any mistakes made in the inputs section of ConcreteWorks. Anytime a user
enters a character not allowed, ConcreteWorks assumes the value of the input to be zero. For
example, if the user types “78u” on the Cement Content input in the Mixture Proportion Inputs
screen, the Input Check screen would show that the cement content is “0”. Figure 29 shows the
Input Check screen. Notice the default values are highlighted green, and the questionable values
are highlighted red.
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Figure 29 - Input Check screen
Default Check
Anytime the user chooses to use the default program value for an input, the Input Check
screen will highlight that value in green. This feature makes it easy for the user to see how many
entries the user actually made.
Questionable Values
Anytime the user enters a value that the program deems questionable, ConcreteWorks
highlights that value red. Just because ConcreteWorks deemed the value questionable does not
always mean that the program will not calculate temperature profiles for the element. A red value
simply means that the user should check to make sure that the value is indeed what the user wanted.
Caution: questionable values can (but not always) cause instability in ConcreteWorks or give
unrealistic results. This feature makes it easy for the user to quickly scan the Input Check screen
for common mistakes in entering data.
Table 1 shows which values are considered questionable by ConcreteWorks.
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Table 1 - Values deemed questionable by ConcreteWorks
If the input is less
than this value

If the input is greater
than this value

Rectangular Column Width or Depth

3'

30'

Rectangular Footing Width, Length

3'

80'

Rectangular Footing Depth

3’

30’

Rectangular Bent Cap Width or Depth

3'

30'

T-Shaped Bent Cap Width

3'

15'

T-Shaped Bent Cap Height

3'

15'

Circular Column Diameter

3'

15'

Cement Content

100#

1200#

Water Content

100#

1200#

Coarse Aggregate Content

100#

4000#

Fine Aggregate Content

100#

4000#

Air Content

0%

10%

Class C Fly Ash Content

0#

1200#

20%

30%

Class F Fly Ash Content

0#

1200#

Class F Fly Ash CaO

0%

20%

Slag Content

0#

1200#

Silica Fume Content

0#

1200#

Ultra-Fine Fly Ash

0#

1200#

Any Bogue Compound Content

0%

100%

Input

Class C Fly Ash CaO

Any Bogue Compound that does not meet
ASTM C 150
C3A

1%

Blaine Fineness

280(m2/kg)

1000(m2/kg)

Alkali Content

0%

100%

Fresh Concrete Placement Temperature

32°F

212°F

PCC age at form removal

0 hrs

Delay between removing forms and cure
method application

0

Hydration Parameter alpha

0
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1.3. Results
1.3.1. Results Summary
After clicking the Calculate Temperatures button on the Input Check screen, ConcreteWorks
will begin performing model calculations for the member type selected. A progress bar will appear
in the lower left corner of the Results screen, showing the calculations’ progress. If a serious error
was made in entering an input, a message box will appear describing the error. The Results screen
has a different heading, depending on the type of member shape chosen.
Mixture Checks
The Mix Checks tab shows a summary table of the calculated results, as seen in Figure 30.
The first section in the Mix Checks table states the set of specifications used to check the calculated
results (for example, the IADOT 2018 specifications), the maximum temperature in the concrete
member during the analysis period, the maximum temperature difference at time t anywhere in the
concrete member, and the original concrete materials CO2 emissions. The second section in the
Mix Checks table tells the user the time to corrosion initiation and damage estimated in the concrete
member. The last section gives the cracking risk classification. A low or moderate cracking risk
classification does not guarantee that the structural member will be free of cracks. A low cracking
risk classification only indicates that the probability of cracking is lower than if the concrete
cracking risk classification were moderate, high, or very high. Any classification, including the
low cracking risk classification, includes some chance that cracking will occur. When the IADOT
2018 specification is selected, the maximum temperature difference line in the Mix Checks table
will be highlighted red if the value exceeds 20°F in the first 24 hours, 30°F in from 24-48 hours,
40°F in from 48-72 hours, and 50°F after 72 hours. The maximum temperature in the member line
will be highlighted if the value exceeds 160°F.
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Figure 30 - Mix Checks tab shown on the Rectangular Footing Temperature Model screen
Max-Min Graph
The Max-Min Graph tab shows the user a graph of the important calculated values with
time, as seen in Figure 31. The values shown are the maximum temperature anywhere in the
concrete member at each point in time, the minimum temperature anywhere in the concrete
member at each point in time, the maximum temperature difference in the concrete member at each
point in time, and the ambient temperature. Also shown in the graph is the IADOT 2018
temperature differential limits for evaluation purpose.
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Figure 31 - Max-Min Graph tab as shown on the Rectangular Column Temperature Model screen
Maturity
The Maturity tab contains a graph that shows the calculated maximum, minimum, and
maximum maturity difference for the concrete member, as seen in Figure 32. The maturity is
calculated from the strength parameters chosen on the Material Inputs screen (see Section 1.2.8).
The calculated maturity is only an estimate, and only applies when the maturity parameters entered
are from same concrete mixture as the one entered.
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Figure 32 - Maturity tab as shown on the Rectangular Column Temperature Model screen
Compressive Strength
The Compressive Strength tab shows the maximum compressive strength, minimum
concrete strength, and the average compressive strength of the concrete member, as seen in Figure
33. The average compressive strength is a weighted average of the compressive strength in the
member. This means that the compressive strength of the concrete member is integrated, and then
divided by the total area. The compressive strength is calculated using the calculated concrete
temperature, the calculated concrete maturity, and the compressive strength parameters entered on
the Mechanical Properties Input screen. If the user does not enter the compressive strength
parameters in the Mechanical Properties Input screen, the concrete compressive strength is not
calculated. The compressive strength graph on the Compressive Strength tab is then not visible.
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Figure 33 - Compressive Strength tab with compressive strength calculated as shown on the
Rectangular Footing Temperature Model screen
Chloride Concentration at the Steel
As part of the chloride service life analysis, ConcreteWorks calculates the chloride
concentration at the steel. When the chloride concentration reaches the chloride threshold level,
corrosion is considered to have initiated. The chloride concentration at the steel level value will
turn orange once corrosion exceeds the chloride threshold level, as shown in Figure 34.
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Figure 34 - Graph of chloride concentration at steel
Cracking Probability Index
The cracking probability index at different times is plotted as a bar chart, with the maximum
temperature difference plotted as a blue line on the same graph to show how the temperature
gradient in the concrete affects the cracking risk classification. Figure 35 shows the graph used to
show the cracking risk classification and maximum temperature difference. The bar color shown
for the cracking risk classification corresponds to the classification shown at the bottom of the
chart. The methodology used to determine the cracking risk classification is discussed earlier. A
green color corresponds to a low cracking risk classification, yellow to moderate, orange to high,
and red to a very high cracking risk classification.
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Figure 35 - Cracking risk classification chart
Thermocouple Points
The Thermocouple Points tab can be used to generate plot of the temperature profile at any
two points and the temperature differential between these points of the mass concrete member as
shown in Figure 36. This feature is useful especially for the analysis of a rectangular footing. There
are two methods of thermocouple point selection. The Point Selection Method can be used to
choose one of the two options – Click on Position and Enter Position. Click on Position enables
the user to click on the sectional view of the mass concrete member and select two points for
analysis. After this, Change Core Point and Change Edge Point can be selected to change the
position of thermocouples on the sectional view figure, as shown in Figure 36. Alternatively, Enter
Position can be used to manually enter the exact location of thermocouples. Changing the
thermocouple location will automatically change the chart shown on the right side. The data of any
combination of two core and edge points can also be extracted as a .txt or .xls file and can be
analyzed.
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Figure 36 – Thermocouple points chart for a Rectangular Footing Temperature Model

1.3.2. Results Screen Buttons
The buttons found on the Results screen give the user choices on how to view and manipulate
the calculated temperature data.
Show Comparison Chart
The Show Comparison Chart button displays a form that allows users to compare the results
from different analysis runs as seen in Figure 37. The Show Comparison Chart screen allows the
user to compare calculated maximum temperatures, maximum temperature differences, cracking
probability classifications, and chloride concentration levels at the steel from one model calculation
run to another. Graphs comparing the results will also be displayed. The Print Chart button on the
Comparison Chart screen will print the comparison chart results and charts on the Comparison
Chart. A PDF report of the printout will be created when the user clicks on the PDF Comparisons
button and will prompt the user for a location to the save the PDF file. The user may name an
analysis run by typing in a name under the Series Name textbox, selecting the number of the
analysis run in the Selected Analysis Number input, and clicking on the Update Series Name button.
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When a user selects the Delete Series button, the analysis run number selected under the Selected
Analysis Number will be deleted.

Figure 37 - Comparison chart screen
Export Temperature Data
To export the temperature data calculated, click on the Export Temperature Data button on
the Results screen. ConcreteWorks saves the data in an ASCII text file when the extension .txt is
used. ConcreteWorks will also save the data as an excel spreadsheet when the extension .xls is
used. Data will be shown for discrete points in the member with time. The default file extension
for data exported is “.xls”.
Cross Section to Be Displayed
ConcreteWorks only displays data in the graphs from two-dimensional cross sections.
When a footing temperature distribution is calculated in three dimensions, the user may change
which cross section is shown in the graphs by changing the Cross-Section Number to be Displayed
value, and then clicking on the Display new cross-section button, as seen in Figure 38. The Mix
Checks values are calculated for the full three-dimensional temperature distributions, however, and
will not change when the Display new cross-section button is clicked. The temperature data
exported when the Export Temperature Data button is clicked (as explained in Section 1.3.2) only
exports the temperature data from the two-dimensional cross section currently selected.
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Figure 38 - Rectangular Footing Results screen with the Cross-Section to be Displayed frame
showing
1.4. Program Features
1.4.1. Printing
While the Results screen is displayed, the user can print out the results and inputs entered
in a report format.
Print
To print the report, click Print under the File menu.
Print Preview
To see of preview of the printed report, click Print Preview under the File menu, as seen in
Figure 39. The report may be printed from the Print Preview window by clicking on the Print
button in the Print Preview window.
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Figure 39 - Print Preview screen
Print Setup
The Print Setup screen allows the user to select which graphs to print in the report. The
Print Setup dialog can be opened by clicking on Print Setup under the File menu. If compressive
strength parameters are not entered in the Mechanical Properties screen, then the Compressive
Strength graph will not print, even if the user selects to print it on the Print Setup dialog. The Print
Setup dialog can be seen in Figure 40.
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Figure 40 - Print Setup dialog
1.4.2. Export
The ConcreteWorks inputs and results can be exported to a PDF file. The PDF file exported
is similar to the printed reports. To make the PDF report, select “PDF” from the “Export to” option
under the File menu. The software will then prompt the user for a location to save the PDF file. It
may take a few minutes for the software to generate the PDF file. After the file has been generated
and saved, ConcreteWorks will display a message that the PDF file was generated.
ConcreteWorks also contains an option to export the inputs to SiteManager™.
SiteManager™ is an AASHTOWare® product used by several state departments of transportation.
The export to SiteManager™ function in ConcreteWorks will create an XML file that can be used
to import ConcreteWorks inputs into SiteManager™.
1.4.3. Save As
To save the inputs entered in a new file, click Save As under the File menu. The default file
extension for an inputs file is “.dat”.
1.4.4. Save File
To save a currently opened file, click the Save button, or click Save under the File menu. If
the Save button is clicked and the file has not previously been saved, the program will prompt for
a name and location.

47

1.4.5. Change Defaults
Click the Change Defaults item under the File menu to change the default values used for
inputs to custom values. All values entered in the Change Defaults screen are input in English units
but are displayed in the correct units in the inputs section of ConcreteWorks the next time a new
file is opened. All units stay the same in the Change Defaults screen, except for the a and b strength
parameters under the Mechanical Properties tab. The a and b parameters change units depending
on the type of maturity function chosen under the same tab. The Material Inputs tab on the Change
Defaults screen is seen on Figure 41.

Figure 41 - Material Inputs tab on the Change Defaults screen
1.4.6. Tools Menu
The Tools menu contains a few options that increase the power and versatility of
ConcreteWorks. The first is the analysis method used to calculate the cement chemical properties.
To select the Bogue method of determining the cement composition, select Bogue (ASTM C 150
2005) under the Cement Analysis Method under the Tools menu. To select the Rietveld method of
determining the cement chemistry, select Rietveld under the Cement Analysis Method under the
Tools menu. Different equations are used to determine the concrete heat of hydration and early age
concrete creep properties based on the cement analysis method selected, as explained in Sections
3.1.5 and 4.5.1.
The specification used in the results check section can be changed by selecting the desired
specification from the Specifications Used option under the Tools menu. ConcreteWorks currently
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only contains the 2004 specifications for the Texas Department of Transportation. If the Basic ASR
and DEF specification is selected, ConcreteWorks will check to see if the predicted maximum
temperature exceeds 160°F, and if the minimum amounts of SCMs prescribed by TxDOT in the
2004 specification are used. If the minimum amounts of SCMs are not used, then a warning that
more investigations should be done is shown. Caution should be used in interpreting this check for
alkali-silica reaction (ASR). Specifications that require the use of minimum amounts of
supplementary cementing materials or maximum cement alkali levels to reduce the likelihood of
ASR do not guarantee that this deleterious reaction will be prevented. Alkali silica reaction is
highly dependent on the aggregate type, type, and quantity of supplementary cementing materials,
alkali loading, and exposure environment.
1.4.7. Help Menu
The Help menu provides the user with useful information about the ConcreteWorks
program.
About ConcreteWorks
When the user clicks on the About ConcreteWorks item under the Help menu, a splash
screen appears with information on the ConcreteWorks version being used, a link to the official
ConcreteWorks website, www.texasconcreteworks.com, and a button that shows the End-User
License Agreement. When the link to the official ConcreteWorks website is clicked,
ConcreteWorks uses Internet Explorer® to navigate to the website—which is why Internet
Explorer is required for using ConcreteWorks (as described in Section 1.1.2).
View User Manual
When the user clicks on the View User Manual item under the Help menu, the
ConcreteWorks User Manual is opened as a new Adobe Reader® process (which is why Adobe
Reader® is required for using ConcreteWorks, as described in Section 1.1.2).
1.5. Input Sensitivities
ConcreteWorks asks the user to input a great deal of data. To receive a correct answer, the
user must enter correct data. Some of the data needed may be hard to obtain. Other data have less
of an effect on the calculated results and performance of the model. This section contains some
comments on these input sensitivities.
1.5.1. Environment Inputs Sensitivity
All of the Environment Inputs directly affect the way heat is transferred to or from the
concrete member to the surrounding environment. Of the four types of environmental inputs, the
temperature inputs have the greatest impact on the resulting temperature distribution in the
element. The relative humidity and cloud cover inputs have a moderate effect on the data. A percent
cloud cover value within 30% is generally acceptable. The wind data can also have a moderate
effect on the calculated temperatures.
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1.5.2. Run Speed
The run speed of the program is one of the biggest concerns to many designers. Following
are the six factors that most influence the run speed of the program:
1. The computer speed and computer RAM
2. Analysis duration—A 14-day duration takes longer to run than a 5-day duration. When a
thermal stress analysis is performed, the analysis duration has a very large impact on the
run time. Because of the numerical methods used, an analysis duration of 4 days may have
a run time several times that of a 3-day analysis, instead of the expected 33% longer
runtime.
3. Member size—the larger the element, the longer the run-time.
4. Concrete age at form removal—the greater the time before form removal, the greater the
run-time.
5. Cure method after form removal—if a cure blanket is used after form removal, the run-time
is longer.
6. Three-dimensional analysis greatly increases the run-time compared to a two-dimensional
analysis.
1.6. Troubleshooting
1.6.1. Installation Problems
If more than one version of the .NET Framework is installed, errors may occur during
installation or when the ConcreteWorks is started. To resolve the issue, try deleting the folder
containing the old version of the .NET Framework, usually found in the directory
C:\WINDOWS\Microsoft.NET\Framework. Before installing or deleting any files or folders, make
sure that the owner of the computer or appropriate network administrator is contacted to obtain
permission and/or assistance.
1.6.2. Screen Settings
The screen settings on the computer running ConcreteWorks may adjust the program’s
appearance. Some of the buttons may be cut off or not visible. The problem may be corrected by
either manually resizing the program windows or adjusting the screen settings on the computer. To
adjust the screen settings on the computer, open up the display settings window by right clicking
on the desktop. Then click on the Settings tab. Then adjust the screen resolution for optimal
software viewing.

50

References

Abrams, D., 1918, “Effect of Time of Mixing on the Strength and Wear of Concrete,” ACI Journal
Proceedings, Vol. 14, No. 6, pp. 22-92.
ACI 207.2, 1995, “Effect of restraint, volume change, and reinforcement on cracking in massive
concrete,” American Concrete Institute, Farmington Hills, Mich., pp. 3-10.
ACI 209.2, 2008, “Guide for Modeling and Calculating Shrinkage and Creep in Hardened
Concrete,” American Concrete Institute, Farmington Hills, Mich., pp. 20-22.
ACI 211, 1991, “Standard Practice for Selecting Proportions for Normal, Heavyweight, and Mass
Concrete, ACI 211.1R, American Concrete Institute, Farmington Hills, Mich., 38 pp.
ACI 305R, 1991, “Hot Weather Concreting – Reported by ACI Committee 305,” American
Concrete Institute, Farmington Hills, Michigan, 20 pp.
ACI 318, 2005, “Building Code Requirements for Structural Concrete (ACI 318-05) and
Commentary (ACI 318R-05),” American Concrete Institute, Farmington Hills, Mich., pp.
99.
Al-Fadhala, M., and Hover, K.C., 2001, “Rapid Evaporation from Freshly Cast Concrete and the
Gulf Environment,” Construction and Building Materials, Vol. 15, pp. 1-7.
Anson, M.; and Newman, K., 1966, "The effect of mix proportions and method of testing on
Poisson's ratio for mortars and concretes," Magazine of Concrete Research, V. 18, No. 56,
pp. 115-130.
ASHRAE, 1993, “1993-ASHRAE Handbook,” American Society of Heating, Refrigerating, and
Air-Conditioning Engineers, Incorporated, Atlanta.
ASTM C 150, 2005, “Standard Specification for Portland Cement,” ASTM International, West
Conshohocken, PA., 8 pp.
ASTM C 1074, 2004, “Standard Practice for Estimating Concrete Strength by the Maturity
Method,” ASTM International, West Conshohocken, PA, 9 pp.
Barber, E.S., 1957, “Calculation of Maximum Pavement Temperatures from Weather Reports,”
Bulletin 168, Highway Research Board, Washington, D.C., pp. 1-8.
Bažant, Z.P., and Panula, L., 1978, “Practical Prediction of Time-Dependent Deformations of
Concrete Part IV: Temperature Effect on Basic Creep,” Matériaux et Constructions, Vol.
11, No. 66, pp. 424-434.
Bentz, E.C., and Thomas, M.D.A., 2001, “Life-365 Service Life Prediction Model™: User
Manual,” 57 pp.
Bernard, O.; Ulm, F.; and Lemarchand, E., 2003, "A multiscale micromechanics-hydration model
for the early-age elastic properties of cement-based materials," Cement and Concrete
Research, V 33, pp. 1293–1309.

51

Bjøntegaard, O., 1999, "Thermal Dilation and Autogenous Deformation as Driving Forces to
Self-Induced Stresses in High Performance Concrete," Doctoral Thesis, Division of
Structural Engineering, The Norwegian University of Science and Technology, 256 pp.
Byard, B.E., 2011, “Early-Age Behavior of Lightweight Aggregate Concrete,” Doctoral
Dissertation, Auburn University, 311 pp.
Byfors, J. 1980, “Plain Concrete at Early Ages,” Research 3:80, Swedish Cement and Concrete
Research Institute, Stockholm, Sweden.
De Schutter, G, Taerwe, L., 1996, "Degree of hydration-based description of mechanical properties
of early age concrete," Materials and Structures, V. 29, July, pp. 335-344.
Emanuel and Hulsey, 1977, “Prediction of the Thermal Expansion Coefficient of Concrete,”
Journal of the American Concrete Institute, Vol. 74, No. 4, pp. 149-155.
Emborg, M., 1989, Thermal Stresses in Concrete Structures at Early Ages,” Doctoral Thesis, Luleå
University of Technology, Division of Structural Engineering, 280 pp.
Emborg, M., 1998a, “Developing Early Age Mechanical Behaviour.” Rilem Report 15, Prevention
of Thermal Cracking in Concrete at Early Ages, Edited by R. Springenschmid, E & Fn
Spon, London, UK, pp. 76-148.
Emborg, M., 1998b, “Models and Methods for Computation of Thermal Stresses,” Prevention of
Thermal Cracking in Concrete at Early Ages, Edited by R. Springenschmid, RILEM Report
15, EF Spon, London, pp 178-230.
Ge, Z., 2006, “Predicting Temperature and Strength Development of the Field Concrete,” Doctoral
Dissertation, Iowa State University.
Glisic, B., 2000, "Fibre optic sensors and behaviour in concrete at early age," Doctoral Thesis,
Swiss Federal Institute of Technology, Lausanne, Switzerland, 154 pp.
Hashida, H., and Yamazaki, N., 2002, “Deformation Composed of Autogenous Shrinkage and
Thermal Expansion due to Hydration of High-Strength Concrete and Stress in Reinforced
Structures,” Proceedings of the Third International Research Seminar on Self-Desiccation
and its Importance in Concrete Technology, Edited by B. Persson and G. Fagerlund, Lund,
Sweden, June 14-15, pp. 77-92.
Hedlund, H., 2000, “Hardening Concrete: Measurements and evaluation of non-elastic
deformation and associated restraint stresses,” Doctoral Thesis, Luleå University of
Technology, Division of Structural Engineering, 394 pp.
Hover, K., 2003, “NHI Course 15123 – Highway Materials Engineering: Portland Cement
Concrete Module – Participant Workbook,”.
Hover, K.C., 2006, “Evaporation of Water from Concrete Surfaces,” ACI Materials Journal, Vol.
103, No. 5, pp. 384-389.
Incropera, F.P.; and Dewitt, D.P., 2002, Fundamentals of Heat and Mass Transfer, John Wiley &
Sons, Inc., New York, p. 931.

52

Jensen, O.M.,and Hansen, P.F., 1999, "Influence of temperature on autogenous deformation and
relative humidity change in hardening cement paste," Cement and Concrete Research, V
29, PP. 567-575.
Kada, H.; Lachemi, M.; Petrov, N.; Bonneau, O.; and Aïtcin, P.C., 2002, "Determination of the
coefficient of thermal expansion of high performance concrete from initial setting,"
Materials and Structures, Vol. 35, No. 245, pp. 35-41.
Krauss, P.D.; Rogalla, E.A., 1996, “Transverse Cracking in Newly Constructed Bridge Decks,”
NCHRP Report 380, Transportation Research Board, Washington, DC.
Larson, M., 2003, “Thermal Crack Estimation in Early Age Concrete – Models and Methods for
Practical Application,” Doctoral Thesis, Division of Structural Engineering, Luleå
University of Technology, 190 pp.
Lydon, F.D., and Balendran, R.V., 1986, “Some Observations on Elastic Properties of Plain
Concrete,” Cement and Concrete Research, Vol. 16, No. 3, pp. 314-324.
Meyers, S.L., 1950, “Thermal Expansion Characteristics of Hardened Cement paste and of
Concrete,” Proceedings, Highway Research Board, Vol. 30, pp. 193-203.
Mindess, S., Young, J.F., and Darwin, D., 2003, Concrete, 2nd Ed., Pearson Education, Inc., Upper
Saddle River, NJ.
Mitchell, L.J., 1953, “Thermal Expansion Tests on Aggregates, Neat Cement, and Concretes,”
Proceedings, ASTM, V. 53, pp. 963-977.
Oluokun, F.A., Burdette, E.G., and Deatherage, J.H., 1991, “Elastic Modulus, Poisson’s Ratio, and
Compressive Strength Relationships at Early Ages,” ACI Materials Journal, Vol. 88, No.
1, pp. 3-10.
Patankar, S.V., 1980, Numerical Heat Transfer and Fluid Flow, McGraw-Hill Book Company,
New York, p. 30-66.
Paulini, P., and Gratl, N., 1994, “Stiffness Formation on Early Age Concrete,” In Rilem Report 25,
Thermal Cracking in Mass Concrete, E & FN Spon, London, pp. 153-160.
Poole, J.L., 2007, “Modeling Temperature Sensitivity and Heat Evolution of Concrete,” Doctoral
Dissertation, The University of Texas at Austin, 299 pp.
Raphael, J.M., 1984, “Tensile Strength of Concrete,” ACI Journal, Vol. 81, No. 2, pp. 158-165.
Rietveld, H.M., 1969, “A Profile Refinement Method for Nuclear and Magnetic Structure,” Journal
of Applied Crystallography, Vol. 2, pp. 65-71.
Riding, K.A., Poole, J.L., Schindler, A.K., Juenger, M.C.G., Folliard, K.J., 2007, “Temperature
Boundary Condition Models for Concrete Bridge Members,” ACI Materials Journal, Vol.
104, No. 4, pp. 379-387.
Riding, K., 2007, “Early Age Concrete Thermal Stress Measurement and Modeling,” Doctoral
Dissertation, The University of Texas at Austin, 588 pp.
RILEM Technical Committee 119-TCE, 1998, “Adiabatic and Semi-Adiabatic Calorimetry to
Determine the temperature Increase in Concrete due to Hydration Heat of Cement,”
53

RILEM Report 15, Prevention of Thermal Cracking in Concrete at Early Ages, Edited by
R. Springenshmid, E & FN Spon, London, pp. 315-330.
Rostasy, F.S.; Gutsch, A.; and Laube, M., 1993, "Creep and Relaxation of Concrete at Early Ages
- Experiments and Mathematical Modeling," Creep and Shrinkage of Concrete, Edited by
Z.P. Bazant and I. Carol, E & Fn Spon, London, pp. 453-458.
Schindler, A.K., 2002, “Concrete Hydration, Temperature Development, and Setting at
EarlyAges,” Doctoral Dissertation, The University of Texas at Austin, 530 pp.
Schindler, A.K., 2004, “Effect of Temperature on Hydration of Cementitious Materials”, ACI
Materials Journal Vol. 101, No. 1, pp. 72-81.
Schindler, A.K., and Folliard, K.J., 2005, “Heat of Hydration Models for Cementitious Materials,”
Vol. 102, No. 1, pp. 24-33.
Schöppel, K., and Springenschmid, R., 1994, “The Effect of Thermal Deformation, Chemical
Shrinkage and Swelling on Restraint Stresses in Concrete at Early Ages,” RILEM Report
25, Thermal Cracking in Concrete at Early Ages, Edited by R. Springenschmid, E & FN
Spon, London, UK, pp. 213-220.
Shilstone, J.M. Sr., and Shilstone, J.M. Jr., 2002, “Performance-Based Concrete Mixtures and
Specifications for Today,” Concrete International, Vol. 24, No. 2, pp. 80-83.
TxDOT, 2004, “Special Provision 421 – Hydraulic Cement Concrete,” Texas Department of
Transportation.
Tuthill, L., and Cordon, W.A., 1955, “Properties and Uses of Initially Retarded Concrete,” Journal
of the American Concrete Institute, Vol. 27, No. 3, pp. 273-286.
Tuutti, K., 1982, “Corrosion of Steel in Concrete,” Swedish Cement and Concrete Research
Institute, Report No. 4-82.
Van Breugel, K., 1998, “Prediction of Temperature Development in Hardening Concrete,” In
Rilem Report 15, Prevention of Thermal Cracking in Concrete at Early Ages, Edited by R.
Springenschmid, E & Fn Spon, London, pp. 51-75.
Viviani, M., 2005, “Monitoring and Modeling of Construction Materials During Hardening,”
Doctoral Thesis, Swiss Federal Institute of Technology, Lausanne, Switzerland, 172 pp.
Walker, S., Bloem, D.L., and Mullen, W.G., 1952, “Effects of Temperature Changes on Concrete
as Influenced by Aggregates,” Journal of the American Concrete Institute, Vol. 48, pp. 661679.
Yamakawa, H., Nakauchi, H., Kita, T., and Onuma, H., 1986, “A Study of the Coefficient of
Thermal Expansion of Concrete,” Transactions of the Japanese Concrete Institute, Vol. 8,
pp. 111-118.
Yoshitake, I., Nagai, S., Tanimoto, T., and Hamada, S., 2002, “Simple Estimation of the Ground
Water Temperature and Snow Melting Process,” Proceedings of The 11th Standing
International Road Weather Commission, Sapporo, Japan, January 26-28, 8 pp.

54

